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more asteroids by highlighting the asteroid sprite and 
�R�T�G�U�U�K�P�I���%�V�T�N�
�&�����;�Q�W���U�J�Q�W�N�F���U�R�T�G�C�F���V�J�G���C�U�V�G�T�Q�K�F�U���Q�W�V��
across the scene, and place the spaceship sprite near 
�V�J�G���D�Q�V�V�Q�O���G�F�I�G�����+�V���U�J�Q�W�N�F���C�N�N���N�Q�Q�M���N�K�M�G���’�I�W�T�G������

As well as controlling graphics, a game engine 
should usually help you get input from the user. In 
Godot this is done with named controls. This enables 
�[�Q�W���V�Q���E�T�G�C�V�G���C���U�R�G�E�K�’�E���C�E�V�K�Q�P���V�J�C�V���[�Q�W���Y�C�P�V���V�J�G���W�U�G�T��
to be able to perform, then easily link it to different 
input methods such as a keypress or joystick 
movement. Our simple game has just two controls: 
left and right spaceship movements. To create these 

controls go to Scene 
> Project Setting > 
Input Map. In the 
action box, enter 
move_left, then click 
Add. This will add an 
entry to the actions 

�N�K�U�V�����%�N�K�E�M���Q�P���V�J�G���R�N�W�U���K�E�Q�P���P�G�Z�V���V�Q���V�J�G���P�G�Y���C�E�V�K�Q�P����
select key input and then press the key you want to 
use to move the ship left. Once this is set up, repeat 
the procedure to create the move_right action.

All your sprites are belong to us
This is everything set up for our game. We just need to 
write the code to bring everything together.

GDScript is a dynamically-typed interpreted 
�N�C�P�I�W�C�I�G���N�Q�Q�U�G�N�[���D�C�U�G�F���Q�P���2�[�V�J�Q�P�����;�Q�W���E�C�P���W�U�G���K�V���V�Q��
create scripts attached to nodes that run as callbacks 
when things happen, which means that the typical 
game will be made up of many small scripts rather 
than one large one. Our game, though, is so basic 
that it’ll just be a single simple script, attached to 
the Node2D node called wholeGame. To create it, 
highlight the wholeGame node in the scene list and 
click on the script icon (the stylised S on the right-
hand side of the toolbar). In the popup, you’ll need 
to enter a path (this can be the same as the game 
�F�K�T�G�E�V�Q�T�[�����V�J�G�P���E�N�K�E�M���Q�P���%�T�G�C�V�G��

The script editor is a text editor with syntax 
highlighting and code completion. The blank script will 
extend the Node2D class and have a function called 
_ready(). The structure of our code will be:
extends Node2D

#setup variables

�H�W�P�E���A�T�G�C�F�[�
����

 #initialise data

�H�W�P�E���A�R�T�Q�E�G�U�U�
�F�G�N�V�C����

 #move ship

�� ���H�Q�T���G�C�E�J���C�U�V�G�T�Q�K�F

  #move asteroid

� � � � ���E�J�G�E�M���K�H���C�U�V�G�T�Q�K�F���J�C�U���J�K�V���U�J�K�R��

 #speed up

Each of the comment lines (which start with a 
�J�C�U�J�����Y�K�N�N���D�G���T�G�R�N�C�E�G�F���K�P���Q�W�T���’�P�C�N���R�T�Q�I�T�C�O���Y�K�V�J���C���D�N�Q�E�M��
of code. Like Python, GDScript uses indentation levels 
to determine which block a particular line of code is in, 
so it’s important to keep consistent in your use of tabs 
or spaces when following this tutorial.

First we need to set up the variables. In GDScript, 
variables need to be declared using the var keyword, 
but only global variables need to be declared at the 
start. Local variables (as you will see) can be declared 
�C�U���C�P�F���Y�J�G�P���V�J�G�[�h�T�G���P�G�G�F�G�F�����6�Q���F�G�’�P�G���V�J�G���I�N�Q�D�C�N��
variables we’ll use, change the #setup variables line to:
�X�C�T���U�J�K�R�A�U�K�\�G

�X�C�T���U�J�K�R�A�U�R�G�G�F����������

�X�C�T���T�Q�E�M�A�U�R�G�G�F����������

The two speed variables can be tweaked to change 
the gameplay if you like. The ship_size variable holds 
the size of the ship, and we’ll use it later on when 
working out the interactions with the asteroids. It’s 
calculated in the _ready function, which is also used 
to start the _process running. Once this is set, Godot 
will continue to loop through the function until it’s 
stopped. The ready function is:
�H�W�P�E���A�T�G�C�F�[�
����

�� �U�J�K�R�A�U�K�\�G�������I�G�V�A�P�Q�F�G�
�k�U�J�K�R�l�����I�G�V�A�V�G�Z�V�W�T�G�
�����I�G�V�A�U�K�\�G�
����

�����I�G�V�A�P�Q�F�G�
�k�U�J�K�R�l�����I�G�V�A�U�E�C�N�G�
��

�� �U�G�V�A�R�T�Q�E�G�U�U�
�V�T�W�G��

As you can see, GDScript can interact with the 
nodes in the game using functions and methods to 
get particular pieces of information. This can be used 
to grab any of the properties of the node. In this case, 
we just need the size and scale of the ship sprite.

The last bit of our code is the _process function. 
Each time this runs, it gets passed a single parameter, 
which is the time it took to run the previous iteration 
of the loop. We call this delta, and it’s used to calculate 
how far to move the sprites. By using this value, we 
�E�C�P���G�P�U�W�T�G���V�J�C�V���Y�G���M�G�G�R���O�Q�X�K�P�I���C�V���C���’�Z�G�F���U�R�G�G�F���
�K�P��
terms of pixels per second) regardless of how fast the 
particular computer runs at.

The _process function will hold most of our game 
logic, but let’s just start with moving the ship. All we 
do in this bit of code is get the current position of 
the code, check that the ship isn’t on the edge of the 
screen and that the input button is pressed (based on 
the actions we set up earlier). If this is the case, then 

Godot is well documented 
�Q�P���V�J�G���R�T�Q�L�G�E�V�h�U���)�K�V�*�W�D��
wiki at �J�V�V�R�U�������I�K�V�J�W�D���E�Q�O��
okamstudio/godot/wiki.

“Like Python, GDScript uses 
indentation levels to determine 
�Y�J�K�E�J���D�N�Q�E�M���C���N�K�P�G���Q�H���E�Q�F�G���K�U���K�P��”
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we move it by the appropriate distance based on the 
speed and the delta value. The code to do this is:
func _process(delta):
 var ship_pos = get_node(“ship”).get_pos()
 if (ship_pos.x > -30 and Input.is_action_
pressed(“move_left”)):
      ship_pos.x+=-ship_speed*delta
 if (ship_pos.x < 30 and Input.is_action_
pressed(“move_right”)):
      ship_pos.x+=ship_speed*delta

 get_node(“ship”).set_pos(ship_pos)
 #move asteroid group

This code is now complete enough to run (although 
the program won’t do anything other than move the 
ship). First you need to save the scene by going to 
Scene > Save and giving the file a name. Once it’s 
saved, you need to tell the game engine that this is the 
first scene you want the program to run. Go to Scene 
> Project Settings > General and edit the Main Scene 
attribute to the file you’ve just saved. With this all in 
place, you can press the Run icon at the top of the 
main window to run the game. You can stop the game 
by either pressing the Stop icon or closing the game 
window.

Asteroids!
With the ship now animated, the next task is to make 
the asteroids move. The easiest way to do this is 
to loop through all the asteroids, and in order to do 
that, we need a way to select all the asteroid nodes. 
Godot enables us to do this by adding all the asteroid 
nodes to a group. Go to the Scene tab, select the first 
asteroid and click on the group icon (two intersecting 
circles). In the new dialog, you can enter a new 
group name and click on Add (we called the group 
asteroids). Repeat this for each of the asteroid sprites.

The group enables us to iterate through the 
asteroids using a for loop as shown in this code:
 #move asteroid group
 for rock in get_tree().get_nodes_in_
group(“asteroids”):

      var rock_pos = rock.get_pos()
      rock_pos.y = rock_pos.y + rock_
speed*delta
      if (rock_pos.y > 35):
           rock_pos.y = -35
           rock_pos.x = randf()*60-30
      rock.set_pos(rock_pos)
  #check for collisions
This moves the asteroid downwards, then checks if 
it’s moved off the bottom of the screen. If it has, the 
code moves the asteroid back to the top of the screen 
and sets it to a random position across the width of 
the screen (so that the pattern doesn’t just repeat).

The ship and asteroids now move, but nothing 
actually happens if one of the asteroids hits the ship. 
In order to make the game work, we need some 
method of identifying whether a collision has taken 
place. There are loads of ways of doing this, but we’re 
going to use a simple approximation. If the centre of 
an asteroid is inside the rectangle around the ship, 
we’ll consider it a collision. This means that there can 
be a small overlap between the two and the ship will 
survive the near miss.

Another thing we have to decide here is what 
happens if the ship hits an asteroid. In other words, 
what is the gameplay? We decided to make the game 
work by gradually speeding up the asteroids, making 
it harder and harder to avoid them. Hitting one of the 
asteroids returns the speed to the initial speed.

This is done with two bits of code. The first to reset 
the speed after a collision:
#check for collisions
     if (ship_rect.has_point(rock_pos)):
          rock_speed = 20

The second goes at the end of the _process 
function and increases rock_speed slightly each time 
it runs:
 #speed up
 rock_speed+=0.02

That’s it! A fully functional, graphical space game in 
just 26 lines of simple GDScript.  

Ben Everard wrote a book about programming Python on the 
Raspberry Pi once, and now he won’t shut up about it.

Deployment Share your creation

If you wish to share your games (or even sell them), Godot 
can help. First, you need to make sure all the components 
you’ve used are licensed for re-use in the way you plan 
to share your game. Godot itself is BSD licensed, so you 
can do whatever you want with games made using this 
toolkit. Any graphics and other artefacts you use may have 
licences that restrict their use in some way.

Providing everything is OK, you can then export your 
game for a wide variety of platforms (Linux, Windows, Mac 
OS X, HTML 5, iOS or Android). You need to get the export 
templates from www.godotengine.org/wp/download, and 
incorporate them into Godot by going to Settings > Install 
Export Templates. With this done, you can export the game 
by pressing the Export button on the main screen. There’s 
some help on how to export on the Godot wiki:  
https://github.com/okamstudio/godot/wiki/export.

The code editor is powerful 
enough for most purposes, 
but you can edit the GD file 
in the text editor of your 
choice if you prefer a more 
customised programming 
experience.
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WHY DO THIS?
•  Gain a better 

understanding of how 
the web works

•  Learn to use Netcat, the 
Swiss Army knife of TCP 
connections

•  Strike up a conversation 
with web servers around 
the world

The Hyper Text Transport Protocol, or HTTP as 
it’s commonly known, is one of the most 
widely used protocols. Almost every time you 

visit a website, you start by entering HTTP which 
signals that you’re trying to get a document via this 
protocol. HTTP is so ubiquitous that even if you don’t 
type this into your browser’s address bar, you’ll default 
to this protocol. 

One of the factors in HTTP becoming so popular is 
its simplicity. It’s incredibly easy to add HTTP support 
to your software. These days, that almost universally 
comes from incorporating a library that handles 
details of the protocol, but even before there were 
quality libraries available, it was simple to add HTTP. 
We’ll take a look at how to interact with the protocol 
using just common command line tools.

HTTP itself runs on top of Transmission Control 
Protocol (TCP), which is a method for connecting two 
machines together over a network and providing a 
two-way data stream between them. We won’t get 
into the nitty-gritty of TCP here; instead we’ll use a 
program that can create a TCP connection and enable 
us to use it from the Linux command line. Netcat (nc) 
is the easiest option for this and should be in your 

distribution’s package manager if it’s not already in 
there by default.

TCP, like HTTP, is client–server. This means that one 
machine (the server) must be set up to wait for a 
communication while the other machine (the client) 
must initiate the communication. When you’re 
browsing the web, you are the client and the various 
websites you visit are the servers. To use Netcat to get 
content from a website, we must first establish a TCP 
connection with the server. You can do that with the 
following command:
nc www.linuxvoice.com 80

The number 80 at the end of the command refers 
to port 80. TCP uses ports to allow a single server to 
host content on many different protocols. Ports are a 
little like the flat or apartment number in a postal 
address. The domain name tells nc which machine to 
connect to just like an address tells a postman which 
building to go to. The port number tells nc what to 
connect to on that machine just like the flat number 
tells a postman which place to deliver the letter. The 
sysadmin can put any piece of software they like at 
any port, just like the building manager can put 
anyone in any flat. 

Pass the port
HTTP servers usually listen on port 80, while (for 
example) SSH servers usually listen on port 22. 
There’s nothing special about these numbers other 
than the convention. You can start an HTTP server on 
any other port if you wish to (and we’ll see how this 
works a little later). 

Running the command won’t do anything obvious. 
In the terminal you should just see a blank line appear 
under the text. In the background, nc has made a TCP 
connection to port 80 on linuxvoice.com. Since HTTP 
is client–server based, the server is still waiting for us 
(the client) to tell it what we want. HTTP is a text-
based protocol which is human readable, so we can 
type commands into this session. The following will 
get the main page from the Linux Voice website:
GET / HTTP/1.1
Host: www.linuxvoice.com

GET is the HTTP verb. It tells the server that we 
want information. You can also send information to 
the server using the POST verb, which is what 
happens usually when you submit a form online. The 
forward slash after the GET is the content that we 
want (in this case, the main page). We then tell the 

CODE NINJA:  
BECOME A WEB SERVER
Delve deep into the heart of the web – and understand how it 
works – by writing raw HTTP requests.

 TUTORIAL
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BEN EVERARD

If you open developer tools in Firefox and click on Console, you can see all the HTTP 
requests that have been used to render the page. Clicking on one of the entries in the list 
will open the details of the request and response headers.
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server that we’re talking to version 1.1 of the HTTP 
protocol. In this version of HTTP, the Host parameter 
is mandatory, so on the next line, we set that to the 
host we’re querying. This might seem odd since we’re 
connecting to this host; however, it’s common 
practice to host more than one domain on a single 
machine, so this makes sure that the web server 
knows which domain we’re requesting.

This is called the HTTP request header. It’s all the 
details that you send to the server. In the real world, 
headers are usually more complex than this. They can 
include, for example, cookie values and details of 
which compression algorithms the browser accepts.

After you’ve typed this, press Enter twice and you 
should then get a response from the server. The first 
part of this response will be the HTTP response 
header, which contains all the details about the 
information being sent back. It should be something 
like the following:
HTTP/1.1 200 OK
Date: Tue, 01 Sep 2015 12:38:02 GMT
Content-Type: text/html; charset=UTF-8
Transfer-Encoding: chunked
Connection: keep-alive
Last-Modified: Tue, 01 Sep 2015 12:28:03 GMT
ETag: W/”22407c-be87-51eaeae6bdac0”
Cache-Control: max-age=3, must-revalidate
Expires: Tue, 01 Sep 2015 12:28:45 GMT
Vary: Accept-Encoding,Cookie
Server: cloudflare-nginx
CF-RAY: 21f107aae1290a90-LHR

The first line includes the status code for the 
response. 200 means that the server has processed 
the response correctly; anything else is an error code. 
404 (content not found) is the most famous HTTP 
error code, but there are others. Much of the rest of 
the response header gives details about how the page 
was served by the server. Below this, you’ll see the 
content of the web page. Note that a single request 
will only receive a single response so it’s up to the web 
browser to make additional requests for images, CSS, 
scripts, etc.

Switching roles
Let’s flip sides now and take a look at what it takes to 
create a HTTP server. This time, we’ll use nc to listen 
on a particular port and respond to a request from a 
web browser. When we requested a web page, we 
requested it from port 80, since that’s the port that’s 
usually used for HTTP. However, it’s possible that 
something’s already serving HTTP through port 80 on 
your machine and only one program can use a port at 
a time. Just to be safe, we’ll serve our HTTP on port 
1500, though you can use a different port if you wish. 
You can start Netcat listening on this port with the -l 
flag to listen and -p1500 to set the port:
nc -l -p 1500

This won’t do anything until we request content. 
You can do this by pointing your browser to http://
localhost:1500. The colon 1500 tells the browser 

what port to use. Once this is done, you’ll see the 
request header appear in the Netcat session.

There are two crucial elements in the response 
header: the response code and the content type. After 
the header, there is a blank line, then the content itself. 
HTTP/1.1 200 OK
Content-type: text/html

<h1>Hello World!<h1>
After pressing 

Return on the final line, 
hit Ctrl+C to kill the 
TCP connection, and 
this will let the browser 
know that the full page 
has loaded so it can be 
rendered.

This manual approach to HTTP isn’t just an 
academic exercise: it can also be useful for debugging 
errors in web servers. Going down this route, you have 
much more visibility of what’s going on, and subtle 
errors can be more obvious.

There are lots more bits that can be used in HTTP 
(most notably compression and encryption), but at its 
heart, it’s a simple text-based protocol. While this was 
a big advantage when small amounts of data were 
being sent over networks, these days there are 
libraries to handle all the complexity and large 
amounts of documents being sent. The initial trade 
off of simplicity over performance is no longer seen as 
a good option. The latest version of the protocol, 
HTTP 2, is more complex and binary rather than 
text-based. Simple clients and servers like the ones 
we’ve used here won’t work with HTTP 2, although 
similar things will still be happening at a lower level. 
With the adoption of HTTP 2, a little bit of the 
readability of the web is dying, so have a chat with a 
web browser or server while you still can.  

HTTP 2 can run much faster than HTTP 1.x. Put the two protocols to the test yourself at  
http://www.http2demo.io.

“The manual approach to HTTP 
can be useful for debugging 
errors in web servers.”
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Smalltalk, famously, was the result of a bet. Alan 
Kay, working at Xerox PARC in the early 70s, 
had been thinking about Simula (the first 

object-oriented language, created for doing 
simulations, and itself based on ALGOL 60), FLEX, and 
LISP. He’d been constructing the basic ideas behind 
Smalltalk for a while, but hadn’t actually gotten into 
implementing it. Kay asserted, in a discussion with 
Dan Ingalls and Ted Kaehler, that you could define “the 
most powerful language in the world” in “a page of 
code” (about the same as McCarthy’s self-describing 
LISP interpreter). They challenged him to prove it. Kay 
set to work, from 4am to 8am daily for the next couple 
of weeks. During the second week, a working version, 
Smalltalk 71, had emerged. And a few days after that, 
Dan Ingalls had coded it up in BASIC and had it 
working, albeit very, very slowly; and from there, they 
just kept going.

The idea of message-passing is fundamental to 
the concept of object-oriented programming; and 
Smalltalk was really the first general OO language 
(Simula was quite specialised), and certainly the 
first popular one. In Smalltalk, everything, and I really 
do mean everything is an object, and the only way 
to engage with an object is to exchange messages 
with it. (Kay, in fact, felt that the message-passing 
aspect was more important than the object aspect.) 
Everything is of the same fundamental type, and 
everything communicates in the same fundamental 
way. You can’t reach in and change things; you have 
to message them. It’s an elegant idea. Kay saw 

object-orientation as being a way of scaling things 
easily: if everything is an object, you can easily create 
whole virtual machines engaging with one another 
via messages. Kay has described objects as “real 
computers all the way down”, able to represent 
anything at any point.

Smalltalk stayed inside PARC for the rest of 
the decade, evolving over the years to include a 
development environment, enabling the coder to 
browse code libraries (included in Smalltalk-76) and 
inspect objects. This was a brand-new idea, and it 
was dependent on the existence of a GUI (graphical 
user interface). The Xerox PARC team had created a 
GUI for the Xerox Alto in 1973. The majority of modern 
GUIs derive from this; and it meant that Smalltalk 
could have a visual IDE in an era when coding was 
otherwise strictly text-based. Dan Ingalls was centrally 
involved in this development of Smalltalk into a usable 
language with a good user interface, and Alan Kay 
has written a fantastic and detailed article on its early 
history (http://gagne.homedns.org/~tgagne/contrib/
EarlyHistoryST.html).

Early projects included a text editor (which could 
also handle multimedia); data retrieval; music 
synthesiser; score capturing; and animations. 
Smalltalk could do pretty much anything.

Smalltalk in the wild
The first Smalltalk to escape into the wider world was 
Smalltalk-80, which was given out for implementation 
on non-Xerox platforms, and to get some more 
feedback. An image was released more widely in 
1983. After that, various versions went off in slightly 
different directions. We’ll be using Squeak, an open-
source implementation derived from Smalltalk-80 
version 1, firstly by a group at Apple (who produced 
Apple Smalltalk), and then by the same group at Walt 
Disney Imagineering. Kay has been a contributor to 
the project.

It’s worth noting that Kay is on record as saying 
that he thinks Smalltalk to some extent got stuck 
in 1972 when they had a helpful working system at 
just the point when it was most needed. He says 
that improvements after that were pragmatic ones, 
whereas when he was initially thinking theoretically 
about Smalltalk there were many other ideas that 
were abandoned. He says he doesn’t much rate any 
modern language including Smalltalk; in particular, 
he is disappointed that the perfectly-scaling virtual 

SMALLTALK: THE ORIGINAL 
OBJECT-ORIENTED LANGUAGE
Meet the grandfather of the Scratch visual programming language 
and remember – everything is an object. 
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JULIET KEMP

Alan Kay with a Dynabook 
mockup (image CC-BY 2.0, 
Magnus Manske).
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internet of machine objects he was thinking of back 
then never arose.

Hello World
You may be able to install Squeak via your package 
manager if you want to try it out, but we found it 
easier to download the all-in-one Zip file from the 
website. (Debian has the squeak-vm package 
available, but you need to download a Squeak image 
from somewhere anyway to use that, and when we 
tried it, it wanted sources too.) Unzip it, go into the 
new directory, and run ./squeak.sh.

The Squeak IDE will appear: a blank screen with a 
few coloured tabs around the edges and some menus 
up top. First, create a new project, with the Projects > 
New Project > Morphic Project menu option. For now, 
click anywhere on the window to get a World menu. 
Choose Workspace, then Transcript. You now have a 
Workspace window, in which you can write code, and 
a Transcript window in which code results and errors 
will appear.

Type this in the Workspace window:
Transcript show: ‘Hello World’.

Squeak commands end with a full stop; use single 
quotes not double, as double quotes in Squeak are 
used to surround comments. Right-click, choose ‘do 
it’, and you’ll see the output in the Transcript window.

This demonstrates basic Squeak syntax: object 
message. Here, Transcript is the object, and show: 
‘Hello World’ is the message, which in this case is a 
method, show, and a string argument.

Let’s try using the Objects tab to edit a button. Click 
on Objects, and drag a Button onto your workspace. 
Middle-click to get the halo of actions around it, and 
click on the light green one. This shows the script for 
this button. Click on the little square to toggle from 
‘tile’ mode to ‘text’ mode, and edit the code to read:
button
    Transcript show: ‘Hello World’.

Right-click and choose ‘accept’, then clicking the 
button and Hello World will show in the Transcript 
window. Note that you can’t revert to tile mode 
without losing these changes (tile mode is more 
limited than text mode).

You can edit the button label by right-clicking and 
choosing “Change label”; you’ll see that there are also 
other options available.

Creating a to-do list
We’re going to start writing a basic to-do list now, to 
try out some more features of Squeak. Open up a new 
Morphic project and put this code into the Workspace:
| todoList item |
todoList := OrderedCollection new.
item := ‘Finish article’.
todoList add: item.
Transcript show: (todoList at: 1).

This creates an OrderedCollection, adds a string to 
it, and outputs that string to the Transcript window. 
The first line declares two temporary variables, 
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Alan Kay circa 1974 – copyright Alan Kay. -

Hello World! There’s also 
a System Browser window 
open in the Squeak IDE.

Kay and the Dynabook
There were a lot of ideas flying around at 
Xerox PARC in the 70s, and Alan Kay was 
involved with many of them. One idea I found 
particularly fascinating was the Dynabook: 
Kay’s version of the iPad, but in 1972. His 
paper is available online (www.mprove.de/
diplom/gui/kay72.html) and well worth a 
read, but basically what he was describing 
was a portable interactive device with a 
network connection, which could be used 
for writing, reading, sharing, playing games, 
coding, and (most importantly for Kay) 
learning. Kay’s description of adults using 
his imagined Dynabook is intimately familiar 
to a 2015 owner of a smartphone or tablet. 
And lots of the ideas around touchscreens 
and GUIs in use today arose from the same 
research projects. The Dynabook, sadly, 
never made it to development as described.

The big difference – and it is an important 
one – between the Dynabook and a modern 
tablet is that Kay described a machine that 
was fundamentally programmable by the 
user. Modern tablets don’t offer that. Sure, 

you can write apps for Android or iOS, but 
you have to do it on a ‘proper’ computer and 
upload; you can’t fiddle directly with the code 
that you’re running on the device itself. Kay, 
in a 2010 interview (www.tomshardware.
com/news/alan-kay-steve-jobs-ipad-
iphone,10209.html), talks a bit about this 
and about how he feels it misses what’s 
special about computers as tools.

Kay at one point in his paper says: “On 
the other hand, the computer also aids in 
the formation of skills concerning ‘thinking’: 
strategies and tactics, planning, observation 
of casual chains, debugging and refinement, 
etc. Rarely does a child have a chance to 
practice these skills in an environment that 
is patient, covert and fun!”. At their best, 
tablets do provide exactly that for children 
(and adults!); and they’re not passive in the 
way that TV, for example, can be. But Kay 
was right that more ability to engage directly 
with the code would be a big improvement. 
You can at least get Squeak and eToys on 
tablets now, so perhaps there is hope yet.
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todoList and item. Other than that, it’s pretty 
straightforward; notice that OrderedCollection is 
indexed from 1, not from 0. To find out more about the 
OrderedCollection methods, or about any other class, 
click on the workspace and open a browser to see all 
the available classes. You can right-click to search.

However, a better idea is to create a new class to 
hold our to do list. Open up the System Browser to 
see all the available Squeak classes. Right-click on the 
category pane (far left), and choose ‘Add item’. Name 
your new category (eg ToDo) and hit Accept. The 
category is now in the list, but without any members.

The template in the bottom pane is the class editing 
pane. This template describes a method that sends 
a subclass message to the Object class, with the 
parameter #NameOfSubclass. This tells the Object 
class to create a new subclass of itself with that 
name. You can also subclass other classes if you 
want to be more specific. Edit the template like this:
BorderedMorph subclass: #ToDoList
    instanceVariableNames: ‘mouseAction’
    classVariableNames: ‘’
    poolDictionaries: ‘’
    category: ‘ToDoList’

You can also add a comment (good practice!). 
We’ve created a subclass of BorderedMorph (morphs 
are graphical objects used in the Morphic graphics 
system), and named it ToDoList. We’ve also added a 
mouseAction instance variable (that is, a variable that 
exists in each instance of the class), which allows us 
to have class methods that react to mouse actions. 
Right-click and click on ‘accept’ to save the changes.

Now create a method to initialise the list. Highlight 
the new class, then click on ‘all’ in the next window 
along. This gives you a method outline. Replace it with 
this:
initialize
    | item item2 |
    super initialize.
    itemTextList := OrderedCollection new.
    itemList := OrderedCollection new.
    item := ‘First thing to do’.
    item2 := ‘Second thing to do’.
    itemTextList add: item; add: item2.

This sets up our object. The first line declares two 
local variables, and the second calls up to the parent 
initialize method (almost always a good idea). We 
then set up two OrderedCollections, one to hold 
a text representation of the list, and the second to 
hold the list items as objects. When you save, you’ll 
need to declare these as instances. We then create 
two strings and add them to the text list (this is for 
demonstration purposes and would come out in later 
stages of developing this code).

Next, let’s create an ‘item’ class, ToDoItem, to 
present our items, in the same way as we created 
ToDoList:
SimpleButtonMorph subclass: #ToDoItem
    instanceVariableNames: ‘mouseAction cellHeight’
    classVariableNames: ‘’
    poolDictionaries: ‘’
    category: ‘ToDoList’

We also need an initialise method for this class:
initialize
    super initialize.
    self label: ‘’.
    self borderWidth: 5.

Trying out code in the 
Workspace, and using 
the System Browser for 
information. Note the 
errors showing up in 
Transcript from previous 
tries.

The Squeak IDE
Smalltalk pretty much invented the IDE, so it’s not 
surprising that Squeak is an IDE-only language. 
(You can run ‘headless’ servers for some Smalltalk 
versions, and it is possible to hack a Squeak image 
to use from the command line, but the default 
image doesn’t allow it.) Compared to modern 
IDEs, it can look and feel a little clunky, but the 
functionality works fine.

Squeak assume that you have a three-button 
mouse, and will map key combinations as 
necessary to fake this if you don’t. Left-click is used 
for selecting, and if you left-click on the workspace 
you get a global menu. Right-click usually brings up 
an options menu, and middle-click (try Alt+click or 
Ctrl+click if you don’t have a middle button) brings 
up the ‘halo’ of buttons around an object; but these 

two are sometimes swapped, so experiment.
When you start a new project, you’ll see various 

tabs on the screen edges. The Objects tab gives 
you objects (like buttons and arrows) that you can 
drag into the screen; Tools, Widgets, and Supplies 
are specific Object subsets, which, again, can all be 
dragged onto the screen to instantiate them. Right-
click and choosing ‘inspect’ or ‘explore’ on a new 
object will show you information about it, including 
a code window at the bottom where you can try 
out code. This tutorial will focus on coding using 
the System Browser, which enables you to add 
classes and code in a more flexible (and likely more 
familiar) way; but it’s possible to do a lot using the 
Morphic graphics system, and it’s worth playing 
around a bit with it. The Squeak window, with the Object tab open.

PRO TIP
Xerox PARC, and other 
ARPA-funded research 
institutions at the 
time, had an impact on 
some hugely important 
computing developments. 
(ARPANET was one of the 
precursors of the internet, 
and developed TCP/IP.)
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    self width: 50.
    self height: self cellHeight.
    color := Color paleBlue.
    self useSquareCorners.

Most of these methods belong to the parent class, 
SimpleButtonMorph, and you can find out more 
about them using the System Browser. However, 
if you try to save this, you’ll get an error telling you 
that Squeak doesn’t know about cellHeight. Choose 
‘declare instance’ to declare this as an instance 
variable, then add another new method:
cellHeight:
    ^50.

^value means ‘return value’. This is the 
recommended way to deal with instance variables 
in Squeak: create a class method to return them. It 
would be a good idea to deal with the hard-coded 
values for borderWidth and width similarly.

So far, we have no connection between ToDoItem 
and ToDoList. Let’s go back to ToDoList and create a 
method to fix that:
createList
    | origin |
    origin := 50.
    itemTextList
        doWithIndex: [:each :i |
        | itemCell |
        itemCell := ToDoItem new.
        itemCell setLabel: each.
        itemCell position: origin @ (origin * i).
        itemList add: itemCell. ]

This uses one of the standard methods for indexed 
collections, doWithIndex. It iterates over the collection, 
returning each item and its index one by one (there’s 
also do, which just iterates over any collection without 
an index), and then applies the code within square 
brackets to each item in turn.

In the bracketed code block, we first deal with the 
two variables which doWithIndex returns on each 
iteration, labelling them [:each :i]. This section of 
the code block is divided from the actual performed 
code by a pipe (|). The first line of performed code 
creates a new local variable, itemCell, which is a 
new ToDoItem. We then use each (the text returned 
by the iterator) as the cell label, and use the index 
to set the position. position refers to the top-left 
corner of the morph, and x @ y gives a point that is 
x pixels along and y down from the top-left corner of 
the whole Squeak workspace. Here we use a fixed 
value (50) to shift the list to the right, and then that 
fixed value multiplied by the index to stack the items 
underneath one another. This must be the same value 
as cellHeight to work properly; try editing the code to 
use that value explicitly.) Finally, we add the cell to the 
OrderedCollection of item objects.

We haven’t yet written the setLabel method in 
ToDoItem. Here it is:
setLabel: text
    self label: text.
    self height: self cellHeight.

setLabel has a single argument (message), and 
uses this to set its label. It also resets the cell height 
as otherwise it will rescale to fit the label, and we want 
our cells to stack up neatly so they need to be the 
same height.

Finally, we need a method to show the list in the 
workspace, again in ToDoList:
showList
    itemList do: [:each | each openInWorld ].

This uses do to iterate over each item in the list and 
show it in the workspace using openInWorld; the code 
structure is the same as doWithIndex.

To create and show the list automatically, add a 
couple of lines to ToDoList initialize:
initialize
    ... code as before ...
    self createList.
    self showList.

Try running it in the workspace with these lines:
| myList |
myList := ToDoList new.

As ever, this is just a starter, to give you the idea of 
how Smalltalk works. There’s a lot more you could do 
with this project, if you want to experiment more, such 
as:

  Add a mouse action to the list cells.
  Write a method to add a new list item.
  Write methods to edit and delete list items.
  Find out how to store the list between invocations.
Check out the excellent Squeak By Example 

(available free online or as a download) for more 
information on Squeak code, which could help you 
with all of the above. And if you have kids, or even if 
you don’t, you can check out Etoys or Scratch, both 
Smalltalk-based coding projects aimed at children. 
(Even two- or three-year-olds can engage with Scratch 
on a tablet.) Morph on…  

Juliet Kemp is a scary polymath, and is the author of  
Apress’s Linux System Administration Recipes.

List showing in top 
left; note debug lines 
in Transcript window. 
Squeak also has a proper 
debugger.
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Internet of Things” is your new 
smartphone: first a toy, then a 
convenience, and finally a necessity. 

Imagine one day you go to work and realise 
you forgot to turn the iron off. With an 
old-style appliance, that’s a problem. With a 
smart one, you just Telnet into it from your 
smartphone and tell it to switch off. Brilliant!

Well, not exactly, if the guy next to you 
can switch your iron back on from his 
smartphone. And that’s essentially what 
network tunnelling is all about. You want 
your internal hosts (not necessary irons!) 
accessible over public networks, but still 
private. There are numerous ways to get 
this in Linux. We’ll stick to OpenSSH, and 
for a good reason. SSH is strong enough 
for you not to worry about privacy being 

compromised. It is also ubiquitous, and 
you’ll hardly find a Linux box without the 
sshd daemon running. 

Down the rabbit hole
Some years ago, I worked for a company 
developing a small office PBX solution. 
Naturally, we used Linux and Asterisk as a 
base. The PBX was usually installed behind 
the firewall, and the Asterisk Management 
Interface (AMI) socket was not accessible 
from the outside. However, one of our 
customers used a cloud CRM solution, and 
he wanted some sort of Asterisk integration 
via AMI.

That was a good use case for SSH port 
forwarding. Port forwarding is a way to bind 
SSH to a local port that securely forwards 

Network tunnelling
Establish ad-hoc secure connections over untrusted networks with OpenSSH.

all data to remote party. So, the CRM guys 
generated a pair of keys and we set up a key-
based authentication (see the boxout). Then 
the customer’s administrator forwarded all 
SSH traffic from his NAT firewall/router to 
the PBX box. Finally, the CRM box made an 
SSH connection to the PBX box, and the 
CRM software connected to a local TCP port 
thinking that Asterisk was listening there. In 
fact, Asterisk was running 1,000 miles away, 
but it was happy to accept that the client 
connections came from the localhost.

There are several things to note in 
this setup. First, the port opened in the 
customer’s firewall wasn’t 22/tcp. This 
helps to keep away bots that scan common 
services like SSH, trying to brute-force 
them. It’s harmless unless you use weak 
passwords (you shouldn’t), but creates noise 
in the logs. So, forwarding a non-standard 
port is a somewhat standard trick; you can 
also consider tools like fail2ban to harden 
things even further. Second, only one port 
was forwarded on the firewall, but it gave the 
CRM box the potential to access the whole 
of the customer’s network. Sometimes you 
want just that, but in our case that was a 
mostly negative side-effect.

A key to this type of “point-to-point” 
tunnelling is the -L switch. A typical 
invocation looks like this:
$ ssh -L 5038:127.0.0.1:5038 -f -N ssh.box

No root permissions are required unless 
you bind to a privileged port. The first 
number is a port to bind at the local side, 
followed by the remote host’s address and 
port. Note that ports do not need to be the 
same: -L 5555:127.0.0.1:5038 would work 
fine, too.

You can also specify the local IP address 
to bind to: -L 192.168.1.22:5038:127.0.Two SSH boxes act like intermediaries for machines wanting a secure point-to-point connection.

CORE
TECHNOLOGYValentine Sinitsyn develops 

high-loaded services and 
teaches students completely 
unrelated subjects. He also has 
a KDE developer account that 
he’s never really used. Prise the back off Linux and find out what really makes it tick.

Encrypted SSH channel
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0.1:5038. This can be useful on a multi-
homed machine, or if you’d like to share a 
tunnel with another box on a local network. 
Alternatively, you can leave out the bind 
address and use the -g command line 
switch. In the example above, if the box 
next to you (say, 192.168.1.23) connects to 
192.168.1.22:5038, it will be really speaking 
to `ssh.box:5038` over a secure channel. 
Naturally, you’ll need to allow incoming 
connections from the local network 
to 192.168.1.22, port 5038/tcp, in the 
system’s firewall first.

Finally, you can play the same trick 
at the remote side. Say, if you use -L 
5038:192.168.2.2:5038, SSH will forward 
your connections to host 192.168.2.2, port 
5038/tcp, over the remote network. With 
all four pieces in place, you can easily build 
a point-to-point tunnel between two hosts, 
using SSH boxes as intermediates.

The -f and -N flags are popular 
companions to -L. The former tells SSH 
to fork and release the terminal. The 
latter prevents it from executing remote 
commands, so you can use a shell-less 
account to forward ports.

This is how you create a tunnel between 
two endpoints known a priori. But what if you 
want to decide on remote party “in flight”?

Knitting socks
In the preceding example, sshd was 
effectively running as a proxy. So if there 
were a way to proxy an arbitrary TCP 
connection, we’d be all set.

One solution is known as SOCKS (short 
for SOCK-et-S), and moreover, it’s an internet 
standard. 

SOCKS proxies usually listen on port 
1080/tcp. A client opens a connection to 
this port and sends a handshake message 
containing the list of authentication 
methods that it supports. The proxy 

chooses one and replies, then the 
authentication process occurs. In simplest 
case, no authentication is performed. Note 
that there is also no built-in encryption.

Next, the client normally sends a 
CONNECT request. It specifies the 
destination address (IPv4/IPv6 or even a 
domain name like www.linuxvoice.com) and 
TCP port that the client wants to connect 
through the proxy. SOCKS v5 adds UDP 
support, but won’t touch it. Then, the proxy 
connects to this endpoint. If it succeeds, 
the client receives the reply saying which IP 
address and port should be used to talk to 
the desired server. Now, all traffic coming 
to the proxy-allocated port is relayed to the 
remote party.

It can also work another way around 
with a BIND request. In this case, the 
client informs the proxy which address 
and port it will listen on. The proxy replies 
with the address and port that the client 
should advertise to the remote party. All 
traffic coming from the outside to a proxy-
allocated port is relayed to the client. This 
way, SOCKS can support active-mode FTP 
and alike.

Many popular clients applications, 
including the Firefox web browser (and, with 
minor issues, Chromium), the Thunderbird 
email client, the Pidgin IM client and many 
others, already come with SOCKS support. 
It is also quite easy to find an anonymous 
SOCKS proxy in any location around the 
globe. Many websites provide up-to-date 
anonymous proxy lists either gratis or for 
a subscription fee. You may use them to 
improve privacy (albeit Tor would probably 
do better) or to circumvent government/
organisational restrictions, eg to access a 
resource that is otherwise unavailable where 
you are. (The legal consequences of doing 
this are always on you.)

Other programs may not come with 
SOCKS support built-in. But the trick is that 
SOCKS maps well to socket API functions 
(LV006). For example, CONNECT is 
connect(3) and BIND is bind(3). So you can 
override these functions with their SOCKS-
aware counterparts via the LD_PRELOAD 

An artificial SOCKS-proxied FTP session. SOCKS messages are in black, FTP messages are in green.

Password-less SSH
In the simplest case, SSH uses password-based 
authentication. However, it’s neither convenient 
nor very secure. Key-based authentication is 
often a better approach. With it, your private key 
is your identity, and you can have as many of 
them as you want. Private keys are usually also 
passphrase-protected, but there are workarounds 
(see Command of the Month), so you can enjoy a 
pure password-less authentication.

First, run ssh-keygen -t rsa to generate an SSH 
keypair. If you already have a default identity (~/.
ssh/id_rsa), add the -f switch to store the new 
keypair under a different name.

Now, transfer the *public* key to the host you 
are going to connect to. The simplest way is 

probably cat ~/.ssh/id_rsa.pub | ssh remoteuser@
hostname ‘cat >> ~/.ssh/authorized_keys’. Close 
the SSH session and try again - you should now 
connect without any password prompt. If this fails, 
check that the keypair files and ~/.ssh/authorized_
keys have the correct permissions. The private key 
should be only owner-readable, and neither file 
should be group writable.

If you have multiple identities, use ssh -i to 
choose the correct one. Alternatively, add this:
Host hostname
  User remoteuser
  IdentityFile ~/.ssh/id_rsa_remoteuser
to ~/.ssh/config. Now, plain ssh hostname should 
suffice.

SOCKS Client
(192.168.1.2)

Proxy
(192.168.1.1.5.6.7.8)

CONNECT 1.2.3.4:21

OK, use 192.168.1.1:10000 Allocate port 10000, 
connect to 1.2.3.4:21

Internet

...FTP commands...

PORT 5.6.7.8:10001

...FTP data...
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trick we discussed back in LV018. Dante 
(www.inet.no/dante), which is a free (as 
in speech) SOCKS server and client library 
implementation for Unix, comes with the 
socksify script, which works just this way. 
It should be available in your distribution’s 
repositories as dante or dante-client. When 
it’s installed, try:
$ SOCKS_SERVER=<address:port> socksify wget 
<url>
wget doesn’t support SOCKS natively, but 
this request should go via the SOCKS proxy 
specified.

 
Dynamic port forwarding
Imagine you’re on a public Wi-Fi 
hotspot. Such networks are usually 
unencrypted, so anyone with the 
wit to use Kismet can sniff your 
traffic. You may think HTTPS 
protects you, and it’s certainly true, 
but there are nuances. First, it 
doesn’t cover DNS requests. This means 
anyone can know which sites you are 
visiting, and it’s bad for privacy. You may be 
just skimming news, but why tolerate a 
stranger reading over your shoulder?

Again, Linux comes with the solution. 
OpenSSH can act as a SOCKS v5 proxy, 
albeit feature-limited: it provides no 
authentication and implements the 
CONNECT method only. However, since it 
uses the SSH channel as a transport, it’s 
automatically encrypted and secure.

To enable it, simply add the -D switch to 
the ssh command line. Officially, this feature 
is called “dynamic application-level port 
forwarding”, so the abbreviation does make 
sense. You should also specify a port that 
the proxy will listen on, and (optionally) the 
local address it should bind to. Remember 

that there is no SOCKS-level authentication 
in SSH. Unless you want to share the tunnel 
with nearby machines (which is unlikely), 
bind to 127.0.0.1 and make sure it’s properly 
firewalled.

You can combine our old friends -f and -N, 
with -D the same way you do for -L. Given 
all of these, a typical command line can look 
like this:
$ ssh -f -N -D 127.0.0.1:1080 ssh.box

Now let’s make our client applications 
use the tunnel. In Firefox and Thunderbird, 
navigate to Edit > Preferences > Advanced, 
choose Network (or Network & Disk Space 
in Thunderbird) and open Connection 

Settings. You should see the dialog shown 
in the screenshot, right. Switch to Manual 
Proxy Configuration, fill in the “SOCKS 
Host” with 127.0.0.1 and “Port” with 1080. 
Leave the SOCKS v5 Switch option as it 
is, and ensure the other proxy fields are 
empty. Newer Firefox releases will also have 
“Remote DNS” checkbox in this dialog. Turn 
it on, or your DNS traffic will go outside the 
tunnel unencrypted (not what you want). 
With Thunderbird, or older Firefox versions, 
open the Config Editor (also known as 
about:config) and make sure ‘network.proxy.
socks_remote_dns’ is set to true. If you find 
yourself changing these settings too often, 
consider using one of the proxy switching 
add-ons available for Firefox.

Now you should have all your web traffic 
forwarded through the tunnel. To check 

that this is the case, run tshark or any other 
sniffer of your liking and try to open a web 
page. If all you see are encrypted packets 
between you and the remote SSH box, 
everything is fine. Occasional DNS requests 
mean that Remote DNS is probably off.

This way, you can regain your privacy over 
an insecure connection. But even if you are 
on a trusted network, there are times you 
may want to access intranet resources like 
your company wiki, which are not available 
from the outside. Usually, field workers use 
VPNs for these purposes (and we’ll also 
discuss it shortly). But if you can SSH into 
your office box (running Linux – what else?), 
you already have all you need.

When you’re done with the tunnel, use kill 
$(pidof ssh) to terminate it.

Ad-hoc VPN
Linux has plenty of VPN solutions.  
A de facto standard is probably OpenVPN 
(www.openvpn.net), which is easy to deploy, 
works well across NATs and is, of course, 
free. However you must still have it installed 
and configured at both sides before using. 
Generally, this is not a problem, but 
sometimes you may want an ad hoc VPN 
without any additional software. For these 
cases, it’s good to know that OpenSSH also 
has built-in VPN capabilities.

This works by creating TUN/TAP 
network interfaces on both sides of an SSH 
connection. TUN/TAP interfaces are virtual 

devices designed for userspace 
networking; TUN is useful for IP 
TUNnelling, while TAP works with 
raw Ethernet frames. Both use  
/dev/net/tun device: what you write 
to it appears as an IP datagram in 
tunX virtual network interface, and 

vice versa. To make the ssh command open 
a TUN/TAP device, use the -w command-line 
switch. The exact type of the device depends 

A secret control panel
Now you’d probably agree that OpenSSH has 
many hidden gems. There is one more for you: 
escape sequences.

Sometimes, an SSH session just hangs and 
Ctrl+C doesn’t help. When this happens, press 
Enter then type ~.. This will force a disconnect. 
Typing ~? brings the list of supported 
escape sequences. You can move SSH to the 
background if you forgot the -f flag with ~^Z 
or list currently forwarded connections (~#), 
among other things. ~C opens a command line 
where you can create new port forwards or 
cancel current ones. The syntax is similar to 
SSH itself, eg -D [bind address]:port, and you 
can get a full reference with the help command.

“You may just be reading the news, 
but why tolerate a stranger looking 

over your shoulder?”

With SSH escape sequences, you can destroy port forwardings and create new ones at run time.
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on the TunnelDevice configuration option. 
For simplicity, we’ll stick to TUN, which is 
the default and should work well unless you 
want broadcasting or non-IP protocols. -w 
accepts the interface number to create on 
the local, and (optionally) the remote side; 
use any if you don’t care. On the server side, 
set PermitTunnel to yes in sshd_config 
and make sure the user you connect as can 
create TUN devices (see tunctl(8)).

To make the setup usable, you’ll also need 
to configure IP addresses at both sides. This 
means the -N switch is no longer suitable. 
Also, as network configuration is a privileged 
operation, you’ll need sudo (or similar) on 
both parties. A typical command to create 
an SSH-based VPN would then be:
ssh -w 0:0 -f \
    -o PermitLocalCommand=yes \
    -o LocalCommand=’sudo ip addr add 
192.168.2.1/24 peer 192.168.2.2 dev tun0; sudo ip 
link set up dev tun0’ \
    user@ssh.box \
    ‘sudo ip addr add 192.168.2.2/24 peer 192.168.2.1 
dev tun0; sudo ip link set up dev tun0’

We request tunnel device (tun0) 
forwarding with -w. For this to succeed, 
the tun kernel module must be loaded, and 
the tun0 device shouldn’t be up at either 
side. Then we override two configuration 
options (PermitLocalCommand and 
LocalCommand), so ssh will execute the 
ip command locally upon successful 
connection. This is to configure the local 
tun0 interface. user@ssh.box is just a 
stub; you should use real user/host name 
here. Finally, a similar ip invocation occurs 
at the remote side to configure the tun0 
device there. TUN interfaces are assigned 
addresses from the 192.168.2.0/24 
network (which was chosen arbitrarily). 

You may also want to add routes to 
make a remote network accessible from 
your place via OpenSSH VPN. This sounds 

similar to what we had in SOCKS case. 
The difference is that now there are no 
intermediates. SOCKS works best for 

accessing the internet through the remote 
network, while VPNs are designed for giving 
access to the remote network itself.

You may need to use the Config Editor when using Mozilla-based products with a SOCKS proxy.

Typing a private key passphrase each time 
is annoying and undermines the very idea of 
password-less logins. On the other hand, 
ditching passphrases altogether hurts 
security. ssh-agent is a small program that 
tries to resolve this. It stores your private 
keys in memory and services related 
operations (like signing) on ssh’s behalf. 

You add keys manually with ssh-add, 
which of course asks you for the passphrase. 
However, it does this only once unless the 

-c or -t switches are used. These enable 
confirmations and key storage timeout, 
respectively. To list keys (or identities) known 
to the agent, use ssh-add -L.

ssh-agent` creates a Unix domain socket 
and stores its path in the SSH_AUTH_SOCK 
environment variable. The socket file has 
strict permissions, so only the user executed 
ssh-agent can access it. Later, ssh connects 
to this socket and requests the agent’s 
services. ssh-agent is usually started at 

the beginning of a user session, from the 
xinitrc or bash_login scripts. It prints shell 
commands to set up the environment, 
which are evaled. Alternatively, ssh-agent 
can run as a session’s parent, so the 
variables are inherited.

With ssh -A, you can forward a local agent 
to a remote host. This is convenient (if you 
make a multi-hop connection) yet insecure, 
as agent forwarding creates a Unix socket 
on intermediate boxes. 

Command of the month: ssh-agent
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Which is more popular – Opera or 
Firefox? It seems like a dumb 
question. Opera all but disappeared 

from the discerning desktop quite some time 
ago after all, and Firefox is the browser app of 
choice on the desktop of the cognoscenti. Well, 
apart from those who use Chrome. And possibly 
excepting the people who run something other 
than Linux on their desktop. In fact, our Linux-
centric world view is at odds with the rest of 
humanity.

But it turns out that actually, our desktop-
centric world view is at odds with humanity. 
Mobile phones are the number one method by 
which people access the web – in many parts of 
the world, the cellphone network is much more 
reliable and a whole lot cheaper than the 
alternatives. Google recently revealed that it 
serves up more search results to mobile users 
than desktop users. Now you aren’t so confident 
in your assumptions, are you…

But never mind. it probably doesn’t matter. As 
it turns out, thanks to the popularity of mobile 
usage, the world wide web isn’t as relevant 
anyway. Who wants to browse eBay or Facebook 
or Amazon in the browser when there is a special 
(faster) app to do it? The internet may be more 
relevant than ever, but web browsers are not. 
Does it matter? Maybe. And probably to more 
folks than the ones working at Mozilla and 
Opera. At least the WWW is a fairly transparent, 
open and easily examinable protocol; who knows 
what those apps are really doing?

[Firefox is still way ahead of Opera by a factor 
of at least five, but due to better mobile exposure 
(there are other choices than Android or iPhone!) 
the latter is doing a lot better than you may think, 
depending on what statistics you ingest (about 
twice as well as it was doing 5 years ago).]

Nick Veitch  
was the original editor 
of Linux Format, a 
role he played until he 
got bored and went 
to work at Canonical 
instead. Splitter! 

CoreOS employee, security expert and FSF board member, now 
internet famous in Linux Voice.

Company branded pint 
glass (US pint)

Dell XPS 13

A pile of TPMs for Grub 
development work

A Minnowboard Max for 
firmware development

What version of Linux are you 
currently using?
Fedora 22. I’ve been using Fedora 
since shortly before I started 

working at Red Hat: it’s still not annoyed 
me enough to switch.

And what desktop do you 
currently use?
Stock Gnome 3.16.

What was the first Linux setup 
you ever used?
Suse 5.2, in the middle of 1998. It 
lasted until Halloween when it got 

replaced with the then just-frozen Debian 
Slink, and everything went downhill after 
that. 

What Free Software/open source 
can’t you live without?
Tough one. Let’s say GCC, because 
we couldn’t have the rest without it

What do other people love but 
you can’t get on with?
Tiling window managers. Ugh..  
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